
CCleaner Beginner's Guide 

Getting Started 

CCleaner is a freeware system optimization and privacy tool. It removes unused files from 
your system - allowing Windows to run faster and freeing up valuable hard disk space. It also 
cleans traces of your online activities such as your Internet history. But the best part is that it's 
fast (normally taking less that a second to run) and contains NO Spyware or Adware! :) 

CCleaner was fully tried and tested with Windows 98/NT4/ME/2000/XP/2003/Vista. It's currently 
partially compatible with 64bit XP and Vista, there are a few non-critical issues which are still 
being worked on. 

Cleans the following: 

 Internet Explorer 
Temporary files, URL history, cookies, Autocomplete form history, index.dat. 

Firefox 
    Temporary files, URL history, cookies, download history.  
Opera 

    Temporary files, URL history, cookies.  

 Windows 
Recycle Bin, Recent Documents, Temporary files and Log files.  

 Registry cleaner 
Advanced features to remove unused and old entries, including File Extensions, ActiveX 
Controls, ClassIDs, ProgIDs, Uninstallers, Shared DLLs, Fonts, Help Files, Application Paths, 
Icons, Invalid Shortcuts and more... also comes with a comprehensive backup feature.  

 Third-party applications 
Removes temp files and recent file lists (MRUs) from many apps including Media Player, 
eMule, Kazaa, Google Toolbar, Netscape, MS Office, Nero, Adobe Acrobat, WinRAR, WinAce, 
WinZip and many more...  

 100% Spyware FREE 
This software does NOT contain any Spyware, Adware or Viruses. 

It contains two essential tools: 
 
1. File Cleaner 
 
This removes files that are not needed by your system, such as: temporary files, internet cache 
files, log files, deleted files in the recycle bin, and many more. The options for what to remove 
are covered by the first two tabs on the left of the main window: Windows and Applications. 
 
2. Registry Cleaner 
 
This scans your registry and highlights issues that may be causing problems. Once scanned you 
may select the issues and fix them. You will be offered the chance the backup any changes as 
well. The options for what to scan are listed on the third tab “Issues” on the main window. 
 



Why should I clean my system? 
 
Do you remember how fast your computer was when you first got it? This is because you hadn't 
yet installed all those demos and utilities that you no longer use. Most of these programs leave 
behind temporary files and registry entries, even when uninstalled! 
 
Additionally your operating system records every visit to every website; every time you open a 
document, and a lot more. Do you want people to be able to find out this information?  
 
Even if you don't mind other people knowing what websites you visit, your internet browser can 
save personal information about you, such as your name, address, date of birth, passwords and 
credit cards numbers. Luckily CCleaner will remove all of these! 

Features 

Program Summary: 

CCleaner is a freeware PC optimization tool. That removes unused and temporary files from 
your system - allowing Windows to run faster, more efficiently and giving you more hard disk 
space. The best part is that it's Small, Fast and Free!  

Cleans the following Windows components:  
 

Internet Explorer   
    - Temporary File Cache.  
    - URL History.  
    - Cookies.  
    - Hidden Index.dat files.  
    - Last download file location. 

  Firefox   
    - Temporary File Cache.  
    - URL History.  
    - Cookies.  
    - Download manager. 
  Opera   
    - Temporary File Cache.  
    - URL History.  
    - Cookies.  

• Recycle Bin  
• Clipboard  
• Windows Temporary files  
• Windows Log files.  
• Recent Documents (on the Start Menu).  
• Run history (on the Start Menu).  
• Windows XP Search Assistant history.  



• Windows XP old Prefetch data  
• Windows memory dumps after crashes.  
• Chkdsk file fragments.  

Advanced Options allow cleaning of:  

• Windows XP old Prefetch data.  
• Menu Order cache  
• Tray Notifications Cache  
• Window Size and Location Cache  
• User Assist history  
• IIS Log Files  
• Custom Folders  

Application Cleaning:  
As well as cleaning up old files and settings left by standard Windows components, CCleaner 
also cleans temporary files and recent file lists for many applications. Including:  

•  Firefox, Opera, Media Player, eMule, Kazaa, Google Toolbar, Netscape, Office XP, Nero, 
Adobe Acrobat, WinRAR, WinAce, WinZip and more...  

Registry Issues Cleaning:  
CCleaner uses an advanced registry cleaner to check for problems and inconsistencies. It can 
check the following:  

• File Extensions  
• ActiveX Controls  
• ClassIDs  
• ProgIDs  
• Uninstallers  
• Shared DLLs  
• Fonts  
• Help File references  
• Application Paths  
• Icons  
• Invalid Shortcuts and more...  

Safety:  
CCleaner was designed from the ground to be safe and secure to use. It has multiple levels of 
checks in place to ensure that it cannot delete any useful information or documents you may 
still need. We also certify that it contains no Spyware or Adware.  

Portability:  
CCleaner can run from a USB thumbdrive and be installed/run on a computer without a 
complicated setup process.  



High Security:  
For the super cautious users we also offer secure file erasing. By overwriting the files before 
deleting them, making it impossible to recover the data.  

Cleaner  

Windows 
 
On your left you have check boxes to select what you would like to clean or not to clean. 
 
Tip: I recommend using the default checked boxes and running Advanced maybe once a month 
or so. 
 
At the bottom of Progress you have Analyze and Run Cleaner. 
 
Clicking on Analyze will create a list of everything CCleaner is going to clean. You can right 
click in the big white box and save the list as a text file. 
 
Clicking on Run Cleaner will clean everything. You can right click in the big white box and save 
the list as a text file. Note: you do not have to run Analyze, if you do not wish too. 
 
Applications 
 
On your left you have check boxes to select what you would like to clean or not to clean. 
 
Tip: I recommend having them all checked. Unless you are a business or use the documents a 
lot, I would uncheck the Office box under Applications. 
 
The Applications cleaning is tied in with the Windows cleaning, so it cleans them both at once. 
You do not have to click on each individual tab to clean Windows and Applications. 
 
Keyboard Shortcuts 
 
ALT+A Analyze 
ALT+C Cancel 
ALT+R Run Cleaner 

Cleaner  

Windows 
 
On your left you have check boxes to select what you would like to clean or not to clean. 
 
Tip: I recommend using the default checked boxes and running Advanced maybe once a month 
or so. 
 
At the bottom of Progress you have Analyze and Run Cleaner. 
 



Clicking on Analyze will create a list of everything CCleaner is going to clean. You can right 
click in the big white box and save the list as a text file. 
 
Clicking on Run Cleaner will clean everything. You can right click in the big white box and save 
the list as a text file. Note: you do not have to run Analyze, if you do not wish too. 
 
Applications 
 
On your left you have check boxes to select what you would like to clean or not to clean. 
 
Tip: I recommend having them all checked. Unless you are a business or use the documents a 
lot, I would uncheck the Office box under Applications. 
 
The Applications cleaning is tied in with the Windows cleaning, so it cleans them both at once. 
You do not have to click on each individual tab to clean Windows and Applications. 
 
Keyboard Shortcuts 
 
ALT+A Analyze 
ALT+C Cancel 
ALT+R Run Cleaner 
  

Cleaner Information 

Windows Tab 
 
Internet Explorer 
 
Temporary Internet Files 
This is the Internet Cache for IE. It saves the web pages and pictures from the sites you're 
visiting to your hard disk. These can build up over time to consume a large amount of disk 
space and may potentially contain personal information. Selecting this option will safely remove 
the files. 
 
Cookies 
Cookies are small text files that Web sites save on your computer to help your browsers 
remember specific information. For example, they might store your username and password. 
They are also used to store your preferences for personalized pages or to build a profile of 
which sites you visit and which banner ads you click on. Advertisers use this information to 
deliver targeted ads directly to your computer. Selecting this option will safely remove the files. 
You may wish to keep certain cookies, these may be selected on the Options window. 
 
History 
Much like the Internet Cache, IE also records and stores the addresses of all the websites you 
have visited. Selecting this option will safely remove the record of websites you have visited. 
 
Recently Typed URLs 



Any website addresses you manually type into the address bar are stored and displayed in the 
address drop-down box. Selecting this option will safely remove the record of typed in 
addresses. 
 
Delete Index.dat files 
Although essentially undocumented by Microsoft there are several hidden files, all with the 
filename index.dat that reside in directories on your system. These permanently cache website 
addresses and cookies from sites you have visited. This list is never deleted and gradually 
increases in size, resulting in IE slowing down. Selecting this option will mark these files for 
deletion the next time your computer is rebooted. (Unfortunately these files cannot be deleted 
immediately as they are permanently in use by the operating system.) 
 
Last Download Location 
When you download a file from the internet, IE remembers the directory location you chose. 
Selecting this option will clear the last directory, and reset to the default folder. On most 
systems the default location is the desktop. 
 
Autocomplete Form History 
When you type in a username and password on a webpage, IE frequently prompts you to select 
whether you'd like it to remember these details for next time. Whilst this is very useful and may 
save you time logging in. It can be a security risk as other people will be able to log in from 
your computer. Selecting this option with remove any stored usernames and passwords. 
 
Windows Explorer 
 
Recent Documents 
When you open a document or file in Windows, a record of this is stored under the Recent 
Documents list on the Start menu. Selecting this option will clear this list. (Note: The documents 
themselves are left untouched.) 
 
Run (in Start Menu) 
An alternative to running programs from a shortcut icon, is to type in the application name into 
the Run form on the start menu. Every time you do this, the program you typed in is added to 
the drop-down list of previously run programs. Selecting this option will clear this list. 
 
Search Assistant Autocomplete 
When you search for a file in Windows Explorer, the file is added to a list of previously searched 
for files. Selecting this option will clear this list. 
 
Other Explorer MRUs 
MRUs (Most Recently Used) are lists within windows and in applications that maintain a list of 
the last few (normally 4 to 8) opened documents. It is normally located on the File menu of the 
application. This option clears a range of minor lists within Windows, including common dialogs, 
network drives and DirectX applications. 
 
System 
 
Empty Recycle Bin 



This option will empty the Recycle Bin. 
 
Temporary Files 
Many applications use temporary files when working to save information. These are normally 
deleted upon exit, but occasionally they can be left behind. Normally when the program is not 
shut down properly. This option will safely delete these files. (By default it only removes files 
that haven't been used in the last 10 days, this prevents current temp files from being removed. 
There is an option to turn off this feature on the Options window.) 
 
Clipboard 
The windows clipboard can contain personal information you've copied from documents and 
also if it contains a large amount of data, it can use up a lot of memory. This option clears the 
clipboard and frees up the memory being used. 
 
Memory Dumps 
When windows crashes or blue screens the system saves a memory dump, potentially 
containing information about how the crash happened. This data is generally never needed, 
even by advanced computer professionals and may be safely deleted. This option will remove 
these memory dumps. 
 
Chkdsk File Fragments 
Chkdsk (CheckDisk) is the utility windows uses to scan the hard disk for files errors. Sometimes 
it finds fragments of files left on your system. These are saved as .CHK files on your system 
drive. In most cases these files are never needed and may be safely deleted. Selecting this 
option will remove these files. 
 
Windows Log Files 
When you install a new program or piece of hardware Windows logs the changes to .LOG files 
in the Windows directory. In most cases these files will never be needed, even for advanced 
users. This option will safely delete these files. 

Start Menu Shortcuts 
Removes start menu shortcuts that points to files that no longer exist. 

Desktop Shortcuts 
Removes desktop shortcuts that points to files that no longer exist. 
 
Advanced 
 
Old Prefetch Data 
In Windows XP a Prefetch file is generated each time an application is run. This helps Windows 
optimize the application the next time it is executed. Unfortunately these files are not deleted 
when the applications are removed. This option removes these files for programs that haven't 
been accessed in 14 days. (This process is very safe and Windows will recreate the files as 
necessary.) 

Menu Order Cache 
The Start menu allows you to set a custom order to the programs listed, although there's no 



option to sort all folders by name. Selecting this option removes any custom ordering from the 
Start menu. 
 
Tray Notifications Cache 
In Windows XP the System Tray (the set of icons next to the clock in the bottom-right corner) 
orders and hides items automatically for you. Whilst this is useful, it records a list of every 
program that has been run from the tray. This option clears the list of previous programs and 
removes any custom display/hide options. (Warning: This won't have any affect until you 
manually restart the explorer process from the Task Manager.) 
 
Window Size/Location Cache 
Windows Explorer stores the view formatting and ordering settings for each folder on your 
system. After some time, this can contain a large amount of redundant data and may even slow 
down browsing for files on your system. Selecting this option will clear this data and reset the 
Windows Explorer display settings to their default option. 
 
User Assist History 
The start menu on Windows XP displays a list of the most recently run programs. Selecting this 
option will clear this list. 
 
IIS Log Files 
IIS (Internet Information Server) is the service Windows uses to display web pages. This comes 
with most XP Pro and Windows 2000 installations and is generally only used by web developers 
or designers. Every time someone requests a page it gets logged to a text file. Unless the 
computer is a web server, these are generally not needed, and may be safely deleted. This 
option will safely delete these files. 
 
Hotfix Uninstallers 
This will remove your Windows Updates from WINDOWS\$NtUninstallKB$, you will not be able 
uninstall the Windows Updates. 
 
Custom Files and Folders 
Will clean your custom files and Folders that you have selected in Options, Customs. 

Registry 

On your left you have check boxes to select what you would like to clean or not to clean. By 
default, all are selected. 
 
Tip: I recommend having them all checked. 
 
Clicking on Scan for Issues will create a check list of everything CCleaner is going to remove 
from the registry. 

Problem - Will tell you what the problem is. You can click on the check box next to Problem 
to check or uncheck all the problems. 

Data - What the registry key is. 



Registry Key - What the full path of the registry key is. 
 
Right clicking on a Problem: 
 
Select All will select everything. 
 
Select All of Type will select everything with the same Problem. Example: Missing MUI 
Reference 
 
Deselect All will deselect everything. 
 
Deselect All of Type will deselect everything with the same Problem. Example: Missing MUI 
Reference 
 
Open in Regedit... will open the selected entry in regedit. This feature may not work if your 
Windows XP account is limited and regedit has been disabled on it. 

Clicking on Fix selected issues... will remove everything selected. Once you click on Fix 
selected issues... you will be asked "Do you want to backup changes to the registry?" It's up 
to you, if you want to or not, but I never had any problems with not backing up. But, I backup 
my full registry every now and then anyways. 
 
Now a window will pop up saying how many there are and what it is. In the top left, it will say 
what the problem is, and at the top is will describe the problem in full. At the bottom you have 
5 buttons. << >> will scroll through all of the problems. Fix Issue will fix each issue one by 
one. Fix All Selected Issues will fix all of the issues you have selected. I tend to click on Fix 
All Selected Issues, because there are so many... Once you are done, just click on Close. 
Many of them might recreate themselves once you restart your computer, but it's ok. It's a 
Windows thing.... Lastly, Close will close the Issue Fix window. 

Issue Scanning Information 

Registry Integrity 

Missing Shared DLLs - Invalid paths to missing shared DLLs. 

Unused File Extensions - File extensions no longer used by programs. 

ActiveX and Class Issues - Invalid paths to ActiveX and Class components that no longer 
installed. 

Type Libraries - Invalid paths to type libraries that no loner exist. 

Applications - Invalid paths to frequently-used programs in the Start Menu. 

Fonts - Invalid paths to fonts that no longer installed. 

Application Paths - Invalid paths to applications that no longer installed. 



Help Files - Invalid paths to help files that no longer installed. 

Installer - Invalid paths to .exe files that no longer there. 

Obsolete Software - Invalid paths to programs that are that no longer in use. 

Run At Startup - Invalid paths to programs that no longer startup with Windows. 

Start Menu Ordering - Invalid folders referenced in the Start Menu. 

MUI Cache - Invalid icons and their string descriptions for various internal Windows uses. 

Restoring Issues Backup 

Go to the folder where your Issues backup is located (default location is My Documents). The 
backup file will be something like this cc_20070130_1437. cc (CCleaner) 20070130 (Year, 
Month, Day) 1437 (Time, 24 hour clock). Right click on the file and click on Merge, you will be 
asked if you would like to add the information or not. 
 
Keyboard Shortcuts 
 
ALT+S Scan for Issues 
ALT+C Cancel 
ALT+F Fix selected issues 

Tools 

Uninstall 
 
You should see a list of Programs that you can uninstall. This list is also found in 

Add/Remove Programs in the Control Panel. On your right you have Run 
Uninstaller, Rename Entry, and Delete Entry. 

 
Run Uninstaller will remove the application from Windows. 
 

Rename Entry will rename it to whatever you want. 
 

Delete Entry will remove the program from Add/Remove Programs. This can come 
in handy if you don't want to remove the program or it's no longer installed, but 
still listed in Add/Remove Programs. 

 
Save to text file... will save the Programs to Remove list. 

 
There is a Right-Click Menu that will list the 4 options as listed above. 
 

Startup 
 

You should see a list of programs that startup when you start Windows. 



 
Enabled (Shows you if the startup program is enabled or disabled) 

Key (Shows where it is located in the registry) 

 
Program (Shows the program's name) 

 
File (Shows where it is located on your hard drive) 

 
On the left you have Disable or Delete Entry. Disable will only disable the 
program from starting up. Delete Entry will remove the program from starting up 

with Windows. Note: Do not use unless you know what you are doing. 

Options 

Settings 
 
Language (The language CCleaner is in) 
 
Run CCleaner when the computer starts (Runs CCleaner when Windows starts up) 
 
Add "Run Cleaner" option to Recycle Bin context menu (This will add Run Cleaner to 
right click menu of the Recycle Bin) 
 
Add "Open CCleaner" option to Recycle Bin context menu (This will add Open CCleaner 
to right click menu of the Recycle Bin) 
 
Automatically check for updates to CCleaner (This will check for a new version of 
CCleaner, checks every 10 mins) 
 
Secure Deletion (Changing the option here will allow for secure file deletion) 

� Normal file deletion (Faster) - Default 
� Simple Overwrite (1 pass) 
� DOD 5220.22-M (3 passes)
� NSA (7 passes)
� Gutmann (35 passes)

Cookies 
 
This will manage your cookies. When cleaning with CCleaner, you may not want to delete a 
certain cookie. So just select it and click the -> button to keep that cookie. Works with 
Internet Explorer and Mozilla Firefox. 
 
Include 
 
This will clean the files and folders that you add. It will list them in the big white box. On your 
right you have Add Folder, Add File, and Remove Folder. It also supports drag-and-drop, 



just drag the file or folder to the window and then you will be prompted to add or not. 
 
Add Folder will add a folder to the custom clean list. 
 
Add File will add a file to the custom clean list. 
 
Remove Selected will remove a file or folder from the custom clean list. 
 
In order to clean custom files or folders, you must have Advanced - Custom Files and 
Folders checked. 

Exclude 
 
This will clean not the files and folders that you add. It will list them in the big white box. On 
your right you have Add Folder, Add File, and Remove Folder. It also supports drag-and-
drop, just drag the file or folder to the window and then you will be prompted to add or not. 
 
Add Folder will add a folder to the custom clean list. 
 
Add File will add a file to the custom clean list. 

Add Registry will add a registry key to the custom clean list. 
 
Remove Selected will remove a file or folder from the custom clean list. 
 
In order to clean custom files or folders, you must have Advanced - Custom Files and 
Folders checked. 
 
Advanced 
 
Only delete files in Windows Temp folder older than 48 hours (This will only remove 
files in the temp folder older than 48 hours) 
 
Hide warning messages (This will hide all warning messages when checking certain cleaning 
boxes) 
 
Close program after cleaning (This will automatically close the program after cleaning) 
 
Show prompt to backup registry issues (This will show a warning box to if you want to 
backup your registry or not) 
 
Show detailed log of Internet Explorer temporary files (This will show the entire log of 
all Internet Explorer files cleaned) 

Show detailed log of Firefox/Mozilla temporary files (This will show the entire log of all 
Firefox/Mozilla files cleaned) 



Minimize to System Tray (This will minimize CCleaner to System Tray) 
 
Save all settings to INI file (This will save all the CCleaner settings to ccleaner.ini instead of 
the Registry) 

Note: Saving to ini can be useful if your Windows account is limited and doesn't have access to 
the registry. 

About 
 
Shows the version number, link to the website, and command-line parameters. 

winapp2.ini 

How to add your own program to CCleaner. 
 
You will need to open Notepad. 
 
Paste this into Notepad: 
 
; Application Cleaning file 
; 
; Notes 
; --------------------------------------- 
; LangSecRef 
; 3021 = Applications 
; 3022 = Internet 
; 3023 = Multimedia 
; 3024 = Utilities 
; 3025 = Windows 
 
Now Save As, in the CCleaner Folder, Save as type: All Files, now Filename: winapp2.ini, and 
click on Save. Now you have a blank cleaning .ini file to begin with. 
 
Ok, let’s look at an entry. (This entry can be found in winapp.ini). 
 
[Remote Desktop] 
LangSecRef=3025 
Detect=HKCU\Software\Microsoft\Terminal Server Client 
Default=True 
FileKey1=%userprofile%\Local Settings\Application Data\Microsoft\Terminal Server 
Client\Cache|*.* 
RegKey1=HKCU\Software\Microsoft\Terminal Server Client\Default 
 
Now, let’s break it down. 
 
[Remote Desktop] Just put whatever name you want in [ ]. 
 



LangSecRef=3025 
3021 = Applications 
3022 = Internet 
3023 = Multimedia 
3024 = Utilities 
3025 = Windows 
 
In order find the registry path for the the program you want to add. Click on Start, Run, and 
type regedit. (Administrator access required) 

Detect=HKCU\Software\Microsoft\Terminal Server Client 

HKCU - HKEY_CURRENT_USER 
HKLM - HKEY_LOCAL_MACHINE 
HKU - HKEY_USERS 
This will detect if the program is installed or not. 

Most programs will be in HKCU, but every now and then. It will be in HKLM. 

To find the program you want to add, go to either HKCU\Software or HKLM\Software. Usually 
the program path will be the company name of who made the program. 

If is a program made by Microsoft, it will be HKCU\Software\Microsoft or 
HKLM\Software\Microsoft 
 
If you need to Detect a program that is installed in a folder use: 
DetectFile= 
Example: DetectFile=%ProgramFiles%\CCleaner\ccleaner.exe 
 
Default=True 
True - Checked when you start CCleaner. 
False - Unchecked when you start CCleaner. 
 
FileKey - Located in a folder. Must start with 1 and then count up. 
FileKey1=%userprofile%\Local Settings\Application Data\Microsoft\Terminal Server 
Client\Cache|*.* 
 
Parameters 

The parameters are basic environment variables in Microsoft Windows. 

Managing Environment Variables & System Variables  

You must be an administrator to modify a system environment variable. System environment 
variables are defined by Windows and apply to all computer users. Changes to the system 
environment are written to the registry, and usually require a restart to become effective. 

User Variables for User Name  



Any user can add, modify, or remove a user environment variable. These variables are 
established by Windows XP Setup, by some programs, and by users. The changes are written to 
the registry, and are usually effective immediately. However, after a change to user 
environment variables is made, any open software programs should be restarted to force them 
to read the new registry values. The common reason to add variables is to provide data that is 
required for variables that you want to use in scripts. 
 
To view or change environment variables:  

1. Right-click My Computer, and then click Properties. 
2. Click the Advanced tab. 
3. Click Environment variables. 
4. Click one the following options, for either a user or a system variable:  

• Click New to add a new variable name and value. 

• Click an existing variable, and then click Edit to change its name or value. 

• Click an existing variable, and then click Delete to remove it. 
 

 
%userprofile% - Current user. Located in Documents and Settings. 
%ProgramFiles% - Program Files. Example: C:\Program Files 
%windir% - WINDOWS folder. 
%rootdir% - Default drive. Example: C:\ 

%appdata% - Example: C:\Documents and Settings\<UserName>\Application Data 
Non-English versions of Microsoft Windows: 
Instead of using %appdata%, you would use %LocalAppData% or %CommonAppData%. 

| - means you want to clean something in that folder. 
*.* - means delete every file in that folder. 
|RECURSE - will delete subfolders and everything with them. Must be followed after *.*. 
Example: %ProgramFiles%\Yahoo!\Messenger\Profiles|*.*|RECURSE 
|REMOVESELF – will delete folder and everything in it. Must be followed after *.*. Example: 
%ProgramFiles%\Yahoo!\Messenger\Profiles|*.*|REMOVESELF 
*.extension will clean any file in that folder with that extension. example: *.log 
You can also just clean certain files. Just add the file name and extension, example: 
deletelog.txt 
 
RegKey - Located in the registry. Must start with 1 and then count up. 
RegKey1=HKCU\Software\Microsoft\Terminal Server Client\Default 
HKCU - HKEY_CURRENT_USER 
HKLM - HKEY_LOCAL_MACHINE 
HKU - HKEY_USERS 
This will delete anything located in the Default Folder. 
 
Parameters: 
| - means you want to clean something in that folder. 
Example: Default|RegistryFile 



 
VBScripting 
 
VBScript support will allow you to add entries to ini files. 
 
ScriptKey1= 
 
It is recommended to have the scripts in the CCleaner folder. 
 
Example: ScriptKey1=test.vbs will target the vbs file in the CCleaner directory. 
 
If you want scripts in other folders other than the CCleaner directory, you will have to list the 
full path. 
 
PARAMETERS will not work in ScriptKey! 

winapp2.ini Entries 

There is a forum thread with lots of entries for winapp2.ini, which was created by users of the 
forum. It can be found here. 

Command-line Parameters 

CCleaner only supports a few command-line parameters. 
 
CCleaner Setup has 3 command-line parameters: 
 
/S - This will install CCleaner with the default options. You will not get a setup screen! 

/D - This will change the default install directory of CCleaner. Example: /D=C:\CCleaner 

Best used like ccsetupXXX.exe /S /D=C:\CCleaner 

/L= - This will install CCleaner with the language file you choose. 

Example: /L=1033 
 
CCleaner has 3 command-line parameters: 
 
/AUTO - Runs the cleaner upon loading and then closes the application. 

The CCleaner /AUTO parameter can be used in and with: 

• Batch files (.bat).  
• Shortcuts/links such as; making one on the desktop named CCleaner (Auto).  
• Via the Windows Task Scheduler.  
• From within CCleaner itself which will allow it to run at every system startup and/or 

logon.  



This is the parameter to use in shortcuts, batch files, or in Task Scheduler (including 
the quotes) (three examples included): 

• "C:\Program Files\CCleaner\ccleaner.exe" /AUTO  
• "%ProgramFiles%\CCleaner\ccleaner.exe" /AUTO  
• "C:\Progra~1\CCleaner\ccleaner.exe" /AUTO  

To make it run at every system startup do the following: 

1. Run CCleaner.  
2. Click Options->Settings, then tick: 

Run CCleaner when the computer starts  
3. Done, you can now close CCleaner. 

Note: This will only clean the User Profile it was enabled on.  

To automatically clean All User Profiles on Windows XP (when each individual user 
logs onto their user profile): 

1. Navigate to: 
C:\Documents and Settings\All Users\Start Menu\Programs\Startup  

2. Right click and create a New Shortcut and input one of the three example parameters 
listed above.  

/DEBUG - Runs the program in debug mode, only recommended for advanced users. 

/SHUTDOWN - This will shutdown your PC after cleaning. Must be used with /AUTO. 
 
The command-line parameters can be useful if you don't want to hit the Close/Exit every time, 
or if you are having a problem, and need to find out what is crashing CCleaner. 
 
To do this, Right Click on the CCleaner shortcut, and then click on Properties. In Target, you 
should see something like this: "C:\Program Files\CCleaner\ccleaner.exe". Just add the 
command-line parameter at the end, it should look something like this: 
"C:\Program Files\CCleaner\ccleaner.exe" /AUTO /SHUTDOWN 

INI-Registry Settings 

This can be useful for the more advanced users. 
 
Registry Path: HKEY_CURRENT_USER\Software\VB and VBA Program 
Settings\CCleaner\Options 

INI Path: CCleaner Directory\ccleaner.ini 
 
(App)Program Name - The program, CCleaner will clean. 
 
True - Checked when you start CCleaner. 
False - Unchecked when you start CCleaner. 



 
These entries are safe to delete, as CCleaner will rebuild them once you Exit CCleaner. 
 
AutoClose - Close program after cleaning. 
0 - Disabled 
1 - Enabled 

BackupDir - Default path for Issues backup. 
Enter path 
 
BackupPrompt - Will prompt you, if you would like to backup the Issues that are about to be 
removed. 
0 - Disabled 
1 - Enabled 
 
CookiesToSave - Will list the cookie names you have saved. 

CustomFiles - Will list the folders you have in Custom Files. 
 
CustomFolders - Will list the folders you have in Custom Folders. 
 
DelayTemp - Only delete files in Windows Temp folders older than 48 hours. 
0 - Disabled 
1 - Enabled 
 
HideWarnings - Hide warning messages. 
0 - Disabled 
1 - Enabled 
 
IEDetailed - Show detailed log of Internet Explorer temporary files. 
0 - Disabled 
1 - Enabled 

FFDetailed - Show detailed log of Firefox/Mozilla temporary files. 
0 - Disabled 
1 - Enabled 
 
Language - The language file installed with CCleaner. 

MinimizeSystemTray - Minimize CCleaner to System Tray. 
0- Disabled 
1- Enabled 
 
MSG_CONFIRMCLEAN - Shows a warning message when you want to Run Cleaner. 
True - Checked when you start CCleaner. 
False - Unchecked when you start CCleaner. 



MSG_WARNMOZCACHE - Shows a warning message when you check Saved Information in 
Mozilla Firefox 
True - Checked when you run Cleaner. 
False - Unchecked when you run Cleaner. 
 
UpdateCheck - Will automatically check for updates (every 10 mins or at CCleaner startup). 
0 - Disabled 
1 - Enabled 
 
SecureDeleteType - Secure Delete 
0 - Disabled 
1 - Enabled 
 
SecureDeleteMethod - Method of Secure Delete 
0 - Simple Overwrite (1 pass) 
1 - DOD 5220.22-M (3 passes) 
2 - NSA (7 passes) 
3 - Gutmann (35 passes) 

UPDATEKEY - The last time CCleaner checked for an update. 
Date and Time 
 
WINDOW_HEIGHT, WINDOW_LEFT, WINDOW_MAX, WINDOW_TOP, WINDOW_WIDTH - 
Window positions of CCleaner. 

Help 

Frequently Asked Questions (FAQ)  
View the questions users most frequently ask about CCleaner. 
We recommend you read this before looking in the other 
sections for help. 

 

Discussion Forum  
Check out our discussion forum and see what CCleaner users 
are talking about. Find out tips on cleaning your system and 
registry. Feel free to join in a discussion and post your own 
messages. Most of us are friendly. ;) 

 
The same items keep immediately re-appearing in subsequent Issues scans after 
attempting to remove them 

• Run the Repair Permissions tool in Dial-a-fix. This will fix it 90% of the time. If you are 
unable to run this tool, try it in "Safe mode with command prompt".  

• Once you extract it, double click on Dial-a-fix.exe, click Tools, click Repair Permissions, 
and click GO. After the permissions repair completes, run a new issues scan in CCleaner 



-- do not remove the objects found by the scan that was performed before the 
permissions repair tool was run.  

• If CCleaner finds its own COM objects, such as CCListView, CCListBar, CCTab, etc, then 
the same answer also applies. 

Restoring an Issue Backup will not work (Windows XP Only) 

• Your file association for registry files has become corrupted.  
• Goto Doug's Windows XP File Association Fixes and download REG File Association Fix 

(Restore default associations for REG files).  
• Unzip xp_regfile.zip, then go to Start > Run > Regedit  
• In the Registry Editor, go to File > Import . Browse to the regfile in question, highlight 

it, and hit 'Open'.  
• Builds 
• There are 3 different versions of CCleaner you can download, which can be found here: 
• http://www.ccleaner.com/download/builds 
• Standard, Portable, Slim 
• Standard 
• The standard version contains all languages and the Yahoo! Toolbar Companion.  
• Note: You do not have to install the Yahoo! Toolbar Companion, simply 
uncheck the Add CCleaner Yahoo! Toolbar and use CCleaner from your 
browser 

• Portable 
• The portable version contains no installer, no Yahoo! Toolbar Companion, and only in 

English. It is used for USB thumb drives or any portable media device. 
• CCleaner can be made portable or you can download the portable version. 
• The CCleaner Portable version comes with a file named "portable.dat" which forces 

CCleaner to save to INI settings. 
• If you already have CCleaner and want to make a portable version, just copy these files 

to a portable media device: 
• ccleaner.exe 

ccleaner.ini 
history.txt 
winapp.ini 

• Also, if you are using winapp2.ini you will need to copy that as well. 
• It is recommended that you download the portable version if you do want a portable 

version of CCleaner. It is small in size and does not require an install. 
• Slim 
• The slim version contains no Yahoo! Toolbar Companion and is only in English. This is 

widely used by system admins and advanced users. 


